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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©0ctober 2013

Trademarks
Intel, Pentium and Intel Cor e are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

\ A/
L&
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the Bluetooth/Wireless LAN modules
at the same time as this may disrupt radio frequency, and cause interference. When the 3G module is powered on, make
sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed bel ow, to reduce therisk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 3.42A (65 Watts) minimum AC/DC Adapter.

This Computer’s Optical Device is a Laser Class 1 Product

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Power Safety

The computer has specific power requirements:

* Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requiresa
steady, uninterrupted power supply. If you are unsure of your local power specifications,

consult your service representative or local power company.

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access

to acompatible outlet, have a qualified electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not

by itswire.

* Make sure the socket and any extension cord(s) you use can support the total current

load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power

supplies (i.e. AC/DC adapter or car adapter).

cord if you are wet.

Do not plug in the power

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.

Preface
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and

power cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.
Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

K eep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

SN
ALK

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwbPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

X1l
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or dightly below the level
of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times a day.

Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

XVI
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, card reader), Touchpad/Mouse and Audio.

e Chapter 3  The computer’s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

» Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructionsfor upgrading your computer.

e Chapter 7 A quick guide to the computer’s PC Camera, WirelessL AN, Combo Bluetooth & WLAN, TPM
(security), Intel and 3G modules (some of which may be optional depending on your purchase
configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

e Appendix C Information on the video driver controls.

» Appendix D The computer’s specification.

. |
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
torefer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “ Upgrading The Computer” on
page 6 - 1 inthe reminder of the User' sManual. Y ou may also find the notes marked with a# of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
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System Startup

1. Remove all packing materials.

2. Place the computer on a stable surface.

3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other

hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

4

(o]
130 Shutdown

Note that you should always
shut your computer down by
choosing the Shut Down
command in Windows (see
page 1 - 34). This will help
prevent hard disk or system
problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

L_________________________________________________________________________________________________________________________________________________|
1 -4 System Startup
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 8.1 operating system is sup-
ported.

Note: In order to run Windows without limitations or decreased performance, your computer requires a mini-
mum 1GB of system memory (RAM).

4

Windows Versions

Note that the information included on the following pages is for Windows 8.1 only.

The Windows 8 interface is slightly different in appearance and in methods of navigation, and a separate manual is pro-
vided on the Device Drivers & Manual Disc for Windows 8.

Windows OS
In order to run Windows 8/8.1 (32 Bit) without limitations or decreased performance, your computer requires a minimum

1GB of system memory (RAM), however if you are running Windows 8/8.1 (64 bit) your computer requires a minimum
2GB of system memory (RAM).

System Startup 1 -5
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Model Differences
This notebook series includes two different models that vary slightly in design style, color, power button style,
general appearance and features supported (see Appendix D for full details). Note that your computer may ook

dlightly different from that pictured throughout this manual.

L_________________________________________________________________________________________________________________________________________________|
1 -6 System Startup
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System Map: LCD Panel Open - Model A Figure 1- 2
9 e e n/_ LCD Panel Open -

RS Model A

Wireless Device Built-in PC Camera
Operation Aboard (Optional)

Aircraft

=

2. PC Camera LED
e The use of any portable 3. Built-In Microphone
electronic  transmission 4. LCD
devices aboard aircraft is 5. Power Button
usually prohibited. Make 6. Keyboard
sure the WLAN & Blue- 7. Touchpad &
tooth module(s) are OFF Buttons
if you are using the com-
@ puter aboard aircraft by
putting the system in to
@ Airplane  Mode (see
).
a Touchpad Buttons

(valid operation area)

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines
indicated on the right.

System Map: LCD Panel Open - Model A 1-7
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Figure 1 - 3 System Map: LCD Panel Open - Model B

LCD Panel Open -
Model B ® & o Y&
1. Built-in PC Camera Wireless Device
(Optional) Operat.ion Aboard
2. PC Camera LED Aircraft
3. Built-In Microphone e The use of any portable
4. LCD electronic  transmission
5. Power Button devices aboard aircraft is
6. Keyboard usually prohibited. Make
7. Touchpad & sure the WLAN & Blue-
Buttons tooth module(s) are OFF
6 if you are using the com-
puter aboard aircraft by
putting the system in to
@ Airplane  Mode (see
).
Touchpad Buttons e

(valid operation area)

Note that the Touchpad and Buttons valid operational area is that indicated within the red dotted lines
indicated on the right.

1 - 8 System Map: LCD Panel Open - Model B



LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Quick Start Guide

Icon Color Description
Orange DC Power is Plugged In
Green The Computer is On

Blinking Green

The Computer is in Sleep Mode

Orange

The Battery is Charging

Green

The Battery is Fully Charged

Blinking Orange

The Battery Has Reached Critically Low Power Status

Green

Airplane Mode is ON (the WLAN, Bluetooth & 3G Modules are OFF)

Green

Hard Disk Activity

Table 1 -1 - LED Indicators

LED Indicators 1 -9
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4

Other Keyboards

Keyboard - Model A

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.
If your keyboard is dam-

aged or you just want to |
make a change, you can
use any standard USB
keyboard. The system will

detect and enable it auto- Play/Pause Key

matically. However spe-

cial  functions/hot-keys Numerical Keypad

unique to the system'’s
regular keyboard may not

work.

NumLk & ScrLk

NumLk &
ScrLk Keys

Windows Logo Key
Hold down the Fn Key 1
and either NumLk or Menu/Application Key

ScrLk to enable number .
or scroll lock, and check Figure 1 - 4 - Keyboard - Model A

the LED indicator for sta-

tus. 4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-10Keyboard - Model A
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4

Other Keyboards

Keyboard - Model B

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.

Function Keys |

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys

Numerical Keypad unique to the system’s

regular keyboard may not
work.

] [ ] T
Menu/Application Key

NumLk &
ScrLk Keys

Play/Pause Key

Hold down the Fn Key

Figure 1 - 5 - Keyboard - Model B and either NumLk or
ScrLk to enable number
/ or scroll lock, and check
the LED indicator for sta-
tus.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Keyboard - Model B 1 - 11
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4

Windows Logo
Keyboard Shortcut

Use the Windows logo
key 3@ + D key com-
bination to switch be-
tween the Start screen
and Windows Desktop.

Menu/Application
Keyboard Shortcut

When the Desktop app
iS running you can use
the Menu/Application
key [E] on the key-
board to display the
context menu as per a
mouse right-click. In
the Start screen this
function is useful to
quickly display the All
Apps icon.

Keyboard Shortcuts

The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi-

gation/operation in Windows 8.1.

Windows Logo Deseriilan

a8 Key +

Tap Winkey Toggle between the Startvifng)r;vznggzEtf;)Fr)emost running app or the
C Display Charms menu
D Switch to the Windows Desktop and toggle show Desktop
E Switch to the Windows desktop andllaunch Windows Explorer with

Computer displayed

F Display file Search
| Open the Settings charm
K Open the Connect charm
L Lock the computer and display the Lock screen
P Display the Second Screen menu (see Figure 1 - 22 on page 1 - 31)
R Switch to the Windows Desktop and display the Run dialog box
z Access the Customize Bar (see Figure 1 - 13 on page 1 - 23)

Table 1 - 2 - Keyboard Shortcuts

1-12 Keyboard - Model B
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
Fn + Play/Pause (in Audio/Video Programs) Fn + Display Toggle
Fan Control Toggle -
En + Automatic Fan Fn + Brightness Decrease/Increase
Control / Full Power
En + PC Camera
Fn+ TouchPad Toggle Power Toggle
Fn+ Turn LCD Backlight Off Fn + Airplane
(Press a key to or use TouchPad to turn on) Mode Toggle
Fn + Mute Toggle Fn + NumLk Number Lock
Toggle
Scroll Lock
Fn + Sleep Toggle Fn + ScrLk Toggle
Caps Lock
Fn +
n Volume Decrease/Increase Caps Lock Toggle

Table 1 - 3 - Function & Hot Key Indicators

.|
Function/Hot Key Indicators 1 - 13
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Control Center

When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click theicon ﬁ inthenatification area of thetaskbar to togglethe Control Center on/off. The Con-
trol Center gives quick access to frequently used controls and enables you to quickly turn the camera/Touch
Pad on/off (see Appendix B for full details).

4

Control Center

Click on any button to turn any of the modules (e.g.
TouchPad, Camera) on/off.

Click on the power conservation modes to switch be-
tween Performance, Balanced or Energy Star modes
(see page 3 - 12). To remove the Power Conservation
Modes screen just click in a blank area of the icon or
press a key on the keyboard.

Click on the buttons (or just click and hold the mouse
button) to adjust the slider for Brightness/Volume.

Click on Display Switch and click to choose a display
mode from the menu (see page C - 18).

Table 1 - 4 - Control Center

1 - 14 Control Center
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System Map: Front & Left Views Figure 1- 6

Front & Left Views

0 1. LED Indicators
9 2.  Multi-in-1 Card
Reader
3. DC-InJack

4, RJ-45 LAN Jack
5. External Monitor

Port
6. Vent/Fan Intake/
Outlet
Multi-In-1 Card Reader 7. HDMI-Out Port

8. 2*USB 3.0 Ports

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memaory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port

This model includes 2 * USB 3.0 ports on the left side of the computer. USB 3.0 ports are
denoted by their blue color; USB 2.0 ports are colored black.

System Map: Front & Left Views 1 - 15



Quick Start Guide

Figure 1 - 7 System Map: Right & Rear Views

Right & Rear Views
1. Microphone-In

Jack
2. Headphone-Out o 9 9 e 6
Jack
3. 1*USB 2.0 Port
(Model C)

OR o0 © © (4 (5]

2*USB 2.0 Ports

(Model D)
4. Optical Device 6
Drive Bay (for CD/
DVD Device)
5. Security Lock Slot e
6. Battery

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely discharge
and charge the battery at least once every 30 days or after about 20 partial discharges.

1-16 System Map: Right & Rear Views
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is
accessing it. This may cause the system to
“crash”. Stop the disk first then eject it, or press
the stop button twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due
to an unexpected power interruption) you may
push the end of a straightened paper clip into the
emergency eject hole. Do not use a sharpened
pencil or any object that may break and become
lodged in the hole. Don't try to remove a floppy
disk/CD/DVD while the system is accessing it.
This may cause the system to “crash”.

Quick Start Guide

4

Changing DVD Regional Codes

Go to the Control Panel and double-click
Device Manager (Hardware and Sound),
then click the + next to DVD/CD-ROM
drives. Double-click on the DVD-ROM de-
vice to bring up the Properties dialog box,
and select the DVD Region (tab) to bring
up the control panel to allow you to adjust
the regional code.

DVD region detection is device dependent,
not OS-dependent. You can select your
module’s region code 5 times. The fifth se-
lection is permanent. This cannot be al-
tered even if you change your operating
system or you use the module in another
computer.

System Map: Right & Rear Views 1 - 17
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Figure 1- 8 System Map: Bottom View - Model A

Bottom View

Model A o
1. Battery
2. Component Bay

Cover

3.  Vent/Fan Intake/
Outlet

4. Hard Disk Bay e 9
Cover

5. Speakers

Ak
- - \, /7
v/ \Y ) <

CPU Overheating

The CPU is not a user To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
serviceable part. while the computer is in use.

1-18 System Map: Bottom View - Model A
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(1

2N
I

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

Quick Start Guide

Figure 1-9
Bottom View
Model B

1. Battery

2. Component Bay
Cover

3.  Vent/Fan Intake/
Outlet

4. Hard Disk Bay
Cover

5. Speakers

CPU

The CPU is not a user
serviceable part.

System Map: Bottom View - Model B 1 - 19
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Windows 8.1 Control Panel

, z _ Throughout this manual you will see an instruction to open the Control Panel.
Windows Versions | pight-click the lower |eft hot corner to bring up the context menu (or usethe Win-
Note that the informa- || dowsLogo Key @ + X key combination) and select Control Panel in both the
tion included on the fol- Desktop app or Start screen.

lowing pages is for
Windows 8.1 only.

The Windows 8 inter-
face is slightly different
in appearance and in
methods of navigation,
and a separate manual
is provided on the De-
vice Drivers & Manual
Disc with reference to
Windows 8.

Desktop app

O~ <

Figure 1 - 10 - Windows Context Menu

1-20 Windows 8.1 Control Panel
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Right-click the Start button in the Desktop app (or use the Windows Logo Key
28 + X key combination) to bring up an advanced context menu of useful features 4
such as Control Panel, Programs and Features, Power Options, Task Manager, Display Most
Search, File Explorer, Command Prompt, Device Manager and Network Connec- Recently Used
tions etc. Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to

get back to the most re-
cently used app.

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen
and right-click the Start button to access the menu.

Figure 1 - 11 - Advanced Context Menu (Right-Click Start Button)

. |
Windows 8.1 Control Panel 1 -21
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Windows 8.1 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runsasan app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows L ogo Key g@ + D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Figure 1 - 12 - Windows Start Screen

1-22 Windows 8.1 Start Screen & Desktop
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Apps & Tiles

The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the dlider at the bottom of the screen
in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps

Y ou can add and remove the tiles for apps and control panelsin the Start screen. Right-click on a blank area
of the Start screen, and you will see the Customize icon. Click the Customize icon to display all theinstalled
applications etc. Right-click any icon to bring up the menu at the bottom of the screen and you can then click the
appropriate icon to pin the App to (or unpin from) the Start screen, or to the taskbar in the Desktop applica-
tion (you can aso open the app in a new window, run as administrator or open the file location).

©

Customize

Figure 1 - 13 - Customize Apps
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Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key g@ + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

When you moveto the lower left hot corner in the Start screen it will take you back to your most recently used
app (if oneisrunning).

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
Figure 1 - 14 - Desktop

.|
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The Charms Bar

Theright side of the screen displaysthe CharmsBar. The CharmsBar containsthe Sear ch, Share, Start, De-
vices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right corners of
the screen, and then hover over one of the itemsin the Charms Bar to activate it (the bar will be black when it
is active), or use the Windows L ogo Key g@ + C key combination.

Figure 1 - 15 - Start Screen with Charms Bar
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Charms Bar Items

Search E: You can search for any file, application, Apps and control panel settings with instantaneous
results.

Share @) This button is used to share information with people viamail or social networks.

Sart .: Click to bring up the Start screen (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen).

Devices B3] Click this button to change connected peripheral device settings e.g. an external display.

SettingsE]: This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settingsto activate the PC Settings menu).

4

Charms Bar - TouchPad Access
To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of the
pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.

3. The Charms Bar will then pop-up.

Figure 1 - 16 - Settings Menu
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Windows 8.1 Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of waysin Windows 8.1.

» Click Search inthe Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the left.

Figure 1 - 17 - Search (Control Panel)

e Clickon ThisPC (in Apps, or you can to pin This PC to the Start screen), click on Computer in the
top menu and select Open Control Panel from the ribbon.

Figure 1 - 18 - Open Control Panel (Computer)
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* Whenin the Desktop app (this does not apply to the Start screen) click on Settingsin the Windows
Charms Bar and select Control Panel from the menu.

-

Figure 1 - 19 - Settings Charms Bar (Desktop App Only)
» Click thearrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).

-

Figure 1 - 20 - All Apps - Control Panel
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» Right-click the Start button to bring up the menu and select Control Panel (see Figure1- 11 on page 1
- 21).

4

Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key § and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Wlndows Iogo key & and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
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Windows 8.1 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar (system tray). In Windows 8.1 the taskbar is accessed from the Desktop application; if you arein the Start
screen you will need to switch to the Desktop.

The taskbar is displayed at the bottom of the Desktop screen, and you can see the notification area (system
tray) of the taskbar in the bottom right of the screen. Some of the control panels and applications referred to
during the course of this manual can be accessed from here.

Figure 1 - 21 - Desktop Taskbar & Notification Area (System Tray)

Y ou can pin/unpin appsto/from the taskbar in much the same way asyou can to the Start screen (see Accessing
Pining/Unpinning All Apps’ on page 1 - 23).
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows when running the Desktop app (see “ Desktop Application” on page 1 - 24
and Appendix C). It is possible to quickly configure external displays from the Devices menu item in the
CharmsBar (see“The CharmsBar” on page 1 - 25).

To Configure Displays from Devices (Charms Bar):

1. Attach your display to the appropriate port, and turn it on.

2. Gothe Charms Bar, select Devices.

3. Click Project (you may need to click Second Screen).

4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen
only.

Figure 1 - 22- Devices (Project)
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To access Display (Control Panel) and Screen Resolution in Windows:
1. Gotothe Control Panel.

2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

4

Right-Click Desktop App

You can right-click the desktop and select Screen
resolution @ (Fig-
ure 1 -23).

View

Use the dropbox to Sort by
select the screen Refresh
Resolution @ (Fig- —

urel - 23) Paste shortcut

Click Advanced set- Undo Rename
tings e (Figure 1= i Graphics Properties...
23) to bring up the
Advanced proper-
ties tabs. New

= Screen resolution o

d Personalize

Graphics Options

Figure 1 - 23 - Screen Resolution
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To access the I ntel (R) HD Graphics Control Panel:

1. Click Advanced settings @ (Figure 1 - 23 on page 1 - 32) in the Screen Resolution control panel in Win-
2. dC(I)i(\;\LSt.he Intel(R)... tab and click Graphics Properties (button) @ (Figure 1 - 24 on page 1 - 33) .

SR Right-click the desktop and select Graphics Properties from the menu.

El).R Click the icon in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

2

Figure 1 - 24 - Intel Graphics Control Panel
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Power Options

Power Options (Hardwar e and Sound) can be accessed from the Control Panel. The Power Menu itemin Set-
tingsin the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hiber nate/
Sleep to the menu - see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 9). Y ou can also use the con-
text menu (Shut down or sign out) shut the computer down/restart etc.

Shut Down, Restart or Sleep (Charms Bar)
1. Go tothe Charms Bar and click Settings.

2. Click Power .
3. Select Sleep, Shut Down or Restart.
Charms Bar Desktop App Start Screen

Figure 1 - 25 - Shut Down/Restart

.|
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Running Apps
To run appsin Windows 8.1 you will need to check that the Screen Resolution and User Account Contr ol Set-
tings are compatible with the system requirements.

Screen Resolution Settings

1. Switch to the Windows Desktop (click the app or use the Windows logo key &@ + D key combination).

2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to
make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Screen Resolution for Apps
(Windows 8/8.1)

The minimum resolution in which Apps will run is 1024x768.

The minimum resolution required to support all the features of
| | Windows 8 (including multitasking with snap) is 1366x768.

These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size.

Figure 1 - 26 - Screen Resolution

.|
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User Account Control Settings

If your computer meets the minimum screen resol ution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.

2. Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).

3. Ifthe slider is in the Never notify position, then the UAC is disabled.

4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.

Figure 1 - 27 - User Account Control

.|
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Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
Multi-In-1 Card Reader
TouchPad and Buttons/Mouse
Audio Features

. |
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Hard Disk Drive

SN
'Ll\ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height

Before attempting to ac- of 9.5 mm or 7mm.

cess any of the internal L .

Selae e e e Thehard disk isaccessible from the bottom of your computer as seen below. For fur-
oA CERERENENTNE  ther details see “ Upgrading the Hard Disk Drive” on page 6 - 4.
that the machine is not

connected to the AC

power, and that the ma-

chine is turned off. Also

ensure that all peripher-

al cables, including

phone lines, are discon-

nected from the comput-

er.

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

4
Thereisabay for a5.25" optical (CD/DVD) device (9.5mm height). The actual de-
vice will depend on the module you purchased (see “ Storage” on page D - 2). The SOA‘(’jrj‘Ss\t/;':nTe

optical device is usually labeled “Drive D:” and may be used as a boot device if

properly set inthe BIOS (see “Boot Menu” on page5 - 15). How high the sound vol-
ume can be set depends

- - on the setting of the vol-
Loadmg Discs ume control within Win-

Toinsert aCD/DVD, press the open button @ and carefully placeaCD/DVD onto | dows. Click the Volume
the disc tray with label-side facing up (usejust enough force for thedisctoclick onto || icon on the taskbar to
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks’ and you fgecdk. theF Sf“'”g" ==
are ready to start. The busy indicator @ will light up while data is being accessed, pa;elg- 13)6_1 drest on
or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency gject hole

© to openthetray. Figure2- 2

Optical Device
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Handling CDs or DVDs

7\[:1'( Proper handling of your CDS/DVDs will prevent them from being damaged. Please
follow the advice bel ow to make sure that the data stored on your CDS/DV Ds can be

CD Emergency Eject
accessed.

If you need to manually

SEei R RETERCRE - Note the following:

an unexpected power

LIEER RS GIER EVAl  » Hold the CD or DVD by the edges; do not touch the surface of the disc.
EERER I ESE o Use aclean, soft, dry cloth to remove dust or fingerprints.
f;{g'g::i?ﬁgrgg?grejﬂg « Do not write on the surface with a pen.

T EENEE e ¢ Do not attach paper or other materials to the surface of the disc.
SNeRRTEEE R ET Rl o Do not store or place the CD or DVD in high-temperature areas.
SRS EIEE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRS EECS . Do not bend the CD or DVD.

db lodged i .
ﬁ]ne hoﬁfome =S8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
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DVD Regional Codes

To change the DVD regional codes: Z

1. Go to the Control Panel DVD Region Note
2. Double-click Device Manager (Hardware and Sound), then click the + next to DVD region detection is
DVD/CD-ROM drives. device dependent, not
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and 0S-dependent. You can
select the DVD Region (tab) to bring up the control panel to allow you to adjust the select your module’s re-
regional code. gion code 5 times. The
) fifth selection is perma-
* Region 1-USA & Canada nent. This cannot be al-

« Region 2 - Western Europe, Japan tered even if you change
' ’ your operating system

South Africa, Middle East & Egypt ST LEE e e i
* Region 3- South-East Asia, Taiwan, another computer.
South Korea, The Philippines, Indo-
nesia, Hong Kong
* Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand
* Region 5- N Korea, Russia, Eastern
Europe, India& Most of Africa _
+ Region 6 - China Figure2- 3
DVD Region Codes
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4

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure2-4

Front View

1. Card Reader

Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“ CardReader” on page 4 - 6.

« MMC (MultiMediaCard) / RSMMC
» SD (Secure Digital) / Mini SD / SDHC / SDXC
* MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

2 - 6 Multi-In-1 Card Reader
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to _
your computer through one of the USB ports. The TouchPad buttons function in Mouse Driver
much the same way as a two-button mouse. If you are using an ex-

ternal mouse your op-
erating system may be
able to auto-configure

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’'s user docu-
mentation for details.

TouchPad and Buttons/Mouse 2 - 7
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TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

Figure2-5
Mouse Properties

Once you have installed the TouchPad driver (see “ Touchpad” on page 4 - 6) you
can configure the functions from the Mouse control panel in Windows, or by double-

clicking the TouchPad driver icon

in the notification area of the taskbar in the

Desktop app. You may then configure the TouchPad tapping, buttons, scrolling,
pointer motion and sensitivity optionsto your preferences. Y ou will find further in-

formation at www.synaptics.com.

4 Mouse Properties

Buttons | Fointers | Pointer Options | Wheel | Hardware | [ Device Settings

Vertical Scroling

e Rl the wheel one notch to scroll

@ fhe following number of lines at a tme-
3B
() One screen at atime
Horizontal Scroling
/TX Tt the wheel to scrol the following number
) of characters at a time

3 ry

G

Apply
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Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac- 4
tion) on the surface of the Touchpad to perform specific actions to manipul ate doc- Show Video
uments, obj ects and applications. You can get a clearer
. . . . . . view of the gestures in-
Y ou can configure the settings from the Device Settings tab in M ouse Properties: volved by clicking the
1. Go to the Control Panel. Show Video option for
A each gesture item.
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings. Select the gesture (Pinch
4. Use the menu tree on the left to access the user configurable settings. Zoom, Rotating, Three
Fingers Down and
Mouse Properties  IEH| Three Finger Flick) in the
Buttons | Peinters | Porter Options | Whes! | Harcward | [ Device Settings Device Settings > Set-
Symaptics Porting nme.vmzmw;u/z tings left tree menu
Devices and click the Show Video

Enabled | Name Port

Yes . Synaplics TouchPad V72 P57 button to see the demon-
stration video.

Diseble For more details on any of
~~—_—

[~ Disable intemal pointing device when extemal USB poirting device i the gestu res see the hel P

Tray lesn in the lower part of the
 Remove tray icon from taskiar H20PH right menu window.
¢ Static tray icon in taskbar A s20PM
(% Animated tray icon in taskbar T 420PM
S Figure2-6
G || ool Mouse Properties -

Device Settings

TouchPad and Buttons/Mouse 2 - 9
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Disabling the Touchpad
If you need to disable the Touchpad for any reason (e.g. you may find that when us-
ing the computer’s internal keyboard you accidentally trigger the Touchpad when
resting your wrists or palmson it) you can do so by using Fn + F1 key combination.

Y ou can also set the system to automatically disable the internal Touchpad when an
external USB point device (e.g aUSB mouse) is attached.

1.
2.
3.

Figure2-7
Mouse Properties
(Disable Touchpad)

Go to the Mouse Properties control panel.
Click to select Device Settings (tab).

Click to place a tick in the “Disable internal pointing device when external USB

pointing device is attached” tickbox.
Click OK to save the setting.

4 Mouse Properties

Buttons | Poirters | Poirter Options | Wheel | Hardw

Devices:

ﬂ] Device 5

Synaptice Pointing Device - v16.2.10.12 24Aug12

e

ettings

Enabled | Name
Ext Synaptice TouchPad V7.2

Paort

P5/2

[w Disable intemal pointing device when extermal USE pointing device is attached:

Tray lcon

e

. |
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Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the

TouchPad surface and slide both fingersin the direction required (in a straight con-

tinuous motion).

Figure2-8
Scrolling Gesture

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

Figure2-9

Zooming Gesture
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2- 10
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

Figure2-11
Flick/Press
Gesture

. |
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Audio Features

Y ou can configure the audio options on your computer from the Sound  control /

panel in Windows, or from the Realtek HD Audio Manager [ icon in the taskbar Volume Adjustment
notification area/control panel (right-click the taskbar notification areaicon fj to | The bsound V‘_"“mﬁ 'e"?'
bring up an audio menu). The volume may also be adjusted by means of the volume can e set using the vol

. . ) . K . j ume control in the Set-
icon in thetaskbar or theaudio dider in the Settings menu (see sidebar). tings menu in the

Charms Bar.

Right-click the icon i
to access the menu
above.

Figure2- 12
Realtek Audio
Manager
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5 Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-

tions below:

1. Goto the Control Panel.

2. Click Realtek HD Audio Manager (Hardware and Sound), or right-click the
taskbar icon ﬂ and select Sound Manager.

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

Figure2- 13
Realtek Audio
Manager -
Recording Setup

2 - 14 Audio Features
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Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
¢ The Power Sources best to refer to the user’s

manual of your operat-

* Turning On the Computer :
ing system.

» Power Plans

» Power-Saving States

» Configuring the Power Buttons
» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

. |
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4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see “ Battery FAQ” on page 3 - 18).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 14.

. |
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow-

er button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use

Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down

Note that you should always shut your computer down by choosing the Shut down

command asthiswill help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context M enu (right-click the lower left corner of the screen
to bring up the menu).

Y ou can aso use the Power Menu in Settingsin the Windows 8.1 CharmsBar . If
you want to add Hibernate/Sleep to the Power Menu see “ Adding Hibernate/Sleep
to the Power Menu” on page 3 - 10.

Charms Bar Desktop App Start Screen

Figure3-1
Shut Down/Restart

3 - 4 Shutting the Computer Down



Power Plans
The computer can be configured to conserve power by means of power plans. Y ou

can use (or modify) an existing power plan, or create anew one.

The settings may be adjusted to set the display to turn off after a specified time, and

to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-

cess further configuration options in Advanced Settings.

o —

N

5
Advanced seftings

Select the power plan that you want to customize, and
\@ then choose settings that reflect how you want your
computer to manage power.

@' Change settings that are currently unavailable

Balanced [Active] v

(= Require a password on wakeup
On battery: ves
Pluggedin: Ves

Hard disk

»» Internet Explorer
Desktop background settings

Wireless Adapter Settings
Sleep
@ _LISR settinas

= Balanced A

Restore plan defaults

Power Management

4

Resuming
Operation

See Table3 - 1, on
page 3 - 11 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-2
Power Plan
Advanced Settings

Power Plans 3 - 5
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Figure3-3

Power Plans

Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High perfor mance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide
additional
power plans
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Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Windows uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last | eft
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

.|
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Wake On LAN
Support

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
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Figure3-4
Power Menu

Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last |eft off within seconds. Y ou should
put your mobile PC into Hiber nate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hiber nate to the
Power Menu see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down
Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hiber nate.

Sleep

Hibernate

Shut down
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Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on

the left menu in Power Optionsto bring up the menu.

Search Control Panel -l

@ b &« All Control Panel tems » Power Options » System Settings v G

Define power buttons and turn on password protection

Choose the power settings that you want for your computer, The changes you make to the settings on this
page apply to all of your power plans,

'@ Change settings that are currently unavailable

Power and sleep buttons and lid settings

j On battery & Pluggedin
0 When | press the power button: | Sleep ¥ |Sleep v
@ When | press the sleep button: | Sleep w| |Sleep v
& When | close the lid: Sleep ¥ |Sleep ¥

Password protection on wakeup

@ Require 2 password (recommended)
When your computer wakes from sleep, no one can access your data without entering the comect
password to unlock the computer. Create or change your user account password

Den't require a password
When your computer wakes from sleep, anyone can access your data because the computerisn't
locked.

Save changes Cancel

Power Management

4

Password
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

A

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-5
Power Options
Define Power
Buttons
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Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Slegp to the Power Menu as follows.

Go to the Power Options (Hardware and Sound) control panel.

Click “Change settings that are currently unavailable” @ change settings that ar= currently unsvsilsble .
Click Choose what the power buttons do.

Click to put a tick in the Hibernate/Sleep box under Shutdown settings.

Click Save Changes and close the control panel.

agpwNE

Figure3-6
Power Options
Define Power
Buttons - Shutdown
Settings
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Resuming Operation
Y ou can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon Color To Resume
Table3-1
Power Off Off Press the Power Button Resuming
Press the Power Button Operation
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off Green Press a Key or Move the Mouse/Touchpad
Power Button 2
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down Closing the Lid
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
R If you have chosen to
button for longer than this will force the computer to shut down).
send the computer to
Sleep when the lid is
closed, raising the lid

will wake the system up.
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Power Conservation Modes

g This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting 1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
will result in maximum & 2 Click either the Performance, Balanced or Energy Star button.
power saving, but with 3. Click in a blank area of the icon or press a key on the keyboard to exit Power

the possible loss of Conservation Mode without making any changes.
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Figure3-7

Control Center
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Ctrl + Alt + Delete Key Combination

YoucanusetheCTRL + ALT + DEL key combination from almost any of the Win-

dows 8 interfaces/Appsto bring up afull-screen displaying L ock, Switch User, Log

off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to

display Sleep, Shut down, and Restart.

Figure3-8
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

.|
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™ Battery Information
PRAS . .
“ Follow these simple guidelines to get the best use out of your battery.
Low Battery
Warning Battery Power
A oA e Y our computer’s battery power is dependent upon many factors, including the pro-
VA e @ grams you are running, and peripheral devices attached. You can set actions to be
ceueas GER Aehlel  taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
SCERCRCRIERENEIESE  power plan Change plan settings > Change advanced power settings (see Figure

or save your work, oth- ] i
erwise, the unsaved 3 -3 on page 3 - 6).

data will be lost when

n : Click the battery icon [ in the notification areato see the current battery level and
e power is depleted.

charge status.

Acvanced setings
= Select the power plan that you want to customize, and
\@ then choose settings that reflect how you want your
<computer to manage power,
® Change settings that are currently unavailable
) [ Display A
F| gure 3 - 9 Multimedia settings
[ Battery
@ Critical battery action
Battery Icon 5 Low battery level
(Notification Area) & On bt 0%
Plugged in: 10%
Battery Advanced & Criicel battery fevel
. On battery: 5%
Setti ngs Pluaned in: 5% v

e
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Conserving Battery Power

» Useapower plan that conserves power (e.g Power saver), however note that Z
this may have an affect on computer performance. Windows Mobility
+ Lower the brightness level of the LCD display. The system will decrease LCD Center

brightness dlightly to save power when it is not powered by the AC/DC adapter. The Windows Mobility

. . . Center control panel
* Reduce the amount of time before the display is turned off. provides an easy point

» Closewireless, Bluetooth, modem or communication applicationswhenthey are | of access for information

not being used. on battery status, power
plans used and wireless
» Disconnect/remove any unnecessary external devices e.g. USB devices, device status etc.
ExpressCards etc.
Figure3- 10
Windows Mobility
Center
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Battery Life

Battery life may be shortened through improper maintenance. To optimizethelife
and improveits performance, fully discharge and recharge the battery at least
onceevery 30 days. It isrecommended that you use the Battery Settingsin the En-
ergy Save Utility to help maintain the life of the battery.

We recommend that you do not remove the battery yourself. If you do need to re-
movethe battery for any reason (e.g. long term storage) see “ Removing the Battery”
on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. Refer to “ LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “ Battery I n-
formation” on page 3 - 14 for more information on how to maintain and properly
recharge the battery pack.

.|
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Proper handling of the Battery Pack
* DO NOT disassemble the battery pack under any circumstances il‘

» DO NOT expose the battery to fire or high temperatures, it may explode Caution
* DO NOT connect the metal terminals (+, -) to each other

Danger of explosion if
battery is incorrectly re-
placed.

AN
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely dischargethe battery?

Use the computer with battery power until it shuts down due to alow battery. Don’t
turn of f the computer even if amessage indicates the battery iscritically low, just let

the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3- 11
Power Plan Create

.|
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3- 12
Change Plan
Settings / Change
Advanced Power
Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Advanced settings Advanced settings
= Select the power plan that you want to customize, and = Select the power plan that you want to customize, and
@ then choose settings that reflect how you want your \@ then choose settings that reflect how you want your
computer to manage power. computer to manage power.
| Discharge Battery [Active] v ‘ | Discharge Battery [Active] v
= Critical battery action " Plugged in: 1% A
H On battery: Shut down = Low battery notification
Fi gure 3-13 Plugged in: On battery: O
Power Options 5 Low battery level Plugged in: Off
H On battery: 0% = Low battery action
Advanced Settlngs Plugged in: 0%
Battery = Critical battery level Plugged in: Do nothing
On battery: 1% = Reserve battery level
Plugged in: 1% On battery: 0%
Low battery notification Plugged in: 0%
1 owas hatten: artinn i 51 ATl Aranhice Druuar Sattinac v
Restore plan defaults Restore plan defaults
[ ok || cancel | ooy oK || Cancel || popy

e Low battery levels= 0%

o Critical battery Levels= 1%

* Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
« Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
Battery Information 3 - 21



Power Management

w
1

22



Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware componentsfor which the latest versions of most available op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

The Device Drivers & Utilities+ User’sManual disc containsthe drivers and util-
ities necessary for the proper operation of the computer. Table4 - 1, on page4 - 3
listswhat you need toinstall and it isvery important that thedriversareinstalled
by the method outlined in this chapter, and in the order indicated.

Note that the information included on the following pagesis for Windows 8.1 only.
A separate manual and set of drivers are provided on the Device Drivers & Manual
Disc for Windows 8.

Module Driver Installation

The proceduresfor installing driversfor the WirelessL AN, Bluetooth & WLAN Com-
bo modules are provided in “Modules & Options’ on page 7 - 1.

What to Install 4 - 1

Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
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Driver Installation

1.

Insert the Device Drivers & Utilities + User’s Manual
disc into the computer’s DVD drive.

Click the message “Tap to choose what happens
with this disc.”

Click Run autorun.exe.

Click Install Drivers (button), or Option Drivers
(button) to access the Optional driver menu.

Figure4 - 1- Drivers Installer Screen 1

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in this
order) which is the same as that listed in the Drivers
Installer menu below.

Click to select the driver you wish to install, (you
should note down the drivers as you install them).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure4 - 2 - Install Drivers

. |
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Win 8.1 System Driver Page # Optional Drivers Page #

Chipset Page 4 - 6 PC Camera Module (No driver required) Page 7 -3

Video (VGA) Page 4 -6 Wireless LAN Module Page 7 - 12

LAN Page 4 - 6 Bluetooth & WLAN Combo Module Page 7 - 17
CardReader Page 4 - 6 Trusted Platform Module Page 7 - 22

Touchpad Page 4 -6 Intel® Rapid Storage Technology Page 7 - 36

Hot Key Page 4 -7 Intel® Rapid Start Technology Driver Page 7 - 37

MEI Driver Page 4 -7 Wireless Display (No driver required) Page 7 - 45

Audio Page 4 -7 3G Module (No driver required) Page 7 - 49

Table 4 - 1 - Driver Installation
All drivers provided are for the Windows 8.1 operating system.

Note that you need to install both the WLAN & Bluetooth driversfor Intel and 3rd party WLAN & Bluetooth
Combo modules.

. |
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go tothe Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
aready received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the install ation proce-
dure.

Drivers & Utilities

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at 4

the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (and the system is not in Airplane Mode) before
installing the appropriate driver.
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 Settings to the highest resolution.

LAN

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.

3. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.
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Airplane

Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 6.Install AirplaneDriver > Yes.

2. Click Next.

3. Click Finish to restart the computer.

Hot Key

1. Click 7.Install Hotkey AP > Yes.

2. Click Next > Next.

3. Click Finish > Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.
2. Click Next > Yes> Next.

3. Click Finish.

Drivers & Utilities

Audio

1. Click 9.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gject
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It is recommended you now also install the Intel Rap-
id Storage Technology driver (see “Intel® Rapid
Storage Technology” on page7 - 36 - required for
AHCI mode hard disks).

(see over)
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Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc., (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1.
2.

3.

Go to the Control Panel.

Click Windows Update (System and Security/
Security).

Click Check for updates (button).

The computer will now check for updates (you
need to be connected to the internet).

Click Install now (button) to begin checking for the
updates.

Click Install updates (button) to install the
updates.

Optional Drivers

Seethepagesindicatedin Table 4 - 1, on page 4 - 3for
the driver installation procedures for any modules in-
cluded in your purchase option.

Figure4 - 3 - Option Drivers

Note that you need to install both the WLAN & Blue-
tooth driversfor Intel and 3rd party WLAN & Blue-
tooth Combo modules.

.|
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: i e e B
screens  pictured on

. these pages are intend-
If your computer has never been set up, or you are making important changesto the BESEERIREREE IRE

system (e.g. hard disk setup), then you should review this chapter first and note the B FSEeNIE S R
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JHEISES
tings you find and any changes you make. This information could be useful if your

- BIOS versions are sub-
system ever needs servicing. ject to constant change

and revision, therefore
Thereis one general rule: Don’t make any changes unless you are sure of what you VSISl lE]

. . . : screens may appear
aredoing. Many of the settings are required by the system, and changing them could slightly _ different _from

cause it to become unstable or worse. If you have any doubts, consult your service  BEFSEE IS T
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

System Date

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will aso change
these settings. Some applications may also alter data files to reflect these changes.
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — copyright (C) 2012 American Megatrends Inc.

Figure5- 3
Advanced Menu

P Intel(R) Smart Connect Technology

Intel(R) Rapid Start Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Start Technology from this menu. The rapid start
hibernation mode can resume power within 5 to 6 seconds and can remember your

computer's state with zero power.

. |
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UEFI Boot

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you
press the key immedi-
ately the system boots

up.

Intel (R) Anti-Theft Technology (Advanced Menu)

Anti-Theft Technology, which is built-in to the processor of the computer, alows
system administrators to render your computer useless to thieves by sending a poi-
son pillencrypted SM S message over a 3G network etc. Administrators can also re-
motely unlock a recovered computer quickly, or direct the system to send location
information (GPS coordinates) back to a central server.

SATA Mode (Advanced Menu)
The SATA (Serial ATA) control is configured to operatein AHCI (Advanced Host
Controller Interface) mode.

Boot Logo (Advanced Menu)

Use this menu item to enable/disable the Boot L ogo screen at system startup if you
have not enabled UEFI Boot. If you disable the Boot L ogo you will not see the F2
Enter Setup or F7 Boot Options prompts on the screen, however you can still press
these keys, while the boot screen is displayed, to perform the Enter Setup or Boot
Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enabl e/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boolt Mode [8tandard]

Secure Boot Mode
Standard
Custom

Figure5-4
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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N2
2

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not apassword should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“ Disabled”.

.|
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Secure Boot Control (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secur e Boot Control isavailable asamenu optionif you
have enabled UEFI Boot (see “UEFI Boot (Boot Menu)” on page5 - 16). En-
abling Secure Boot will bring up the Secur e Boot M ode menu to enable you to con-
figure Secure Boot as Standar d (with afixed secure boot policy) or Custom (which
enables you to make changes to the Key M anagement database).

.|
Security Menu 5 - 11
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Figure5-5
Security Device
Support

TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to accessthe Security Device Support menu
and select Enable to display the full TPM configuration menu (see “ Trusted Plat-
form Module” on page 7 - 22 for details).

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

TPM SUPPORT [Disable]
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TPM Sate (Security Menu > Security Device Support Enabled)
Select TPM State, press Enter and select Enabled to change the TPM state to en-
abled. Y ou will then need to press F4 to save the changes and restart the computer.

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

TPM SUPPORT [Enabkle]

Figure5-6
TPM State (Enabled)

Asthe computer restarts press F2 to enter the BIOS again and go to the TPM Con-
figuration menu.

Security Menu 5 - 13
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Figure5-7
Pending TPM
operation
(Enable Take
Ownership)

5 - 14 Security Menu

Pending TPM operation (Security Menu > Security Device Support & TPM Sate
Enabl ed)

Select Pending oper ation, press Enter and select the option you require (if you are
initializing TPM you should select Enable Take Owner ship). Y ou will then need
to press F4 to save the changes and restart the computer. You can now install the
TPM driver (see” Trusted Platform Module (TPM) Driver I nstallation” on page 7
- 25) and then initialize the TPM.

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Pending operation [Honel

Pending TPM operation
Hone
Enable Take Ownership
Disable Take Ownership
TPM Clear
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Boot Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Boot .
Figure5-8
Boot Menu

Boot Option #1 [Windows Boot Manager]

SN
ALK

BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

S . your computer's actual
When you turn the computer on it will look for an operating system (e.g. Windows TS TR Cpeey

7) from the devices listed in this menu, and in this priority order. If it cannot find ~ EESFRRIENHAEAEE T
the operating system on that device, it will try to load it from the next device in the B GEEETREEL R NG
order specified in the Boot Option Priorities. Item specific help on the right is §EEESE

available to help you move devices up and down the order.

Boot Menu 5 - 15
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Boot Option Priorities (Boot Menu)

Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option un-
der UEFI Boot.

5 - 16 Boot Menu
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Exit Menu

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

- Figure5-9
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to itsoriginal state, and erase any previous changes you have madein
aprevious session.

Exit Menu 5 - 17
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Upgrading The Computer

Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problemsyou can con-
tact your service representative for further help. Before you begin you will need:

» A small crosshead or Phillips screwdriver
* A small regular slotted (flathead) screwdriver
e Anantistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive

» Hard Disk Size Note (Foam Rubber Insert)
» Upgrading the System Memory (RAM)

Please make surethat you review each procedur e before you perform it.

N2
2

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Overview 6 - 1
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

6 - 2 Overview

When Not to Upgrade
These procedures involve opening the system’ s case, adding and sometimes replac-
ing parts.

Y ou should not perform any of these upgradesif:

* Your system is still under warranty or a service contract
* Youdon't have al the necessary equipment

* You'renot in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

2MN\L
I

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with afast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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Removing the Battery ™

If you are confident in undertaking upgrade procedures yourself, for safety reasons ’ﬁl\ .

it is best to remove the battery. Warranty Warning
1. Turn the computer off, and turn it over. Please check with your
2. Slide the latch @ in the direction of the arrow. service representative
3. Slide the latch @ in the direction of the arrow, and hold it in place. before undertaking any
4. Slide the battery out in the direction of the arrow @. upgrade procedures to

find out if this will VOID
your warranty.

Figure6-1
Battery Removal

Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive

\ A/
’Ll\ The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard

H[\)/\[/) System disk driveswith aheight of 9.5mm or 7.0mm (see “ Storage” on page D - 2). Follow
arning

your operating system’s installation instructions, and install all necessary drivers

N R el and utilities (see “ Driver Installation” on page 4 - 2), when setting up a new hard
fore you begin make sure: disk.
You have backed up any

Sgﬁ"; S SEIE  |f you are replacing an existing hard disk with anew disk of adifferent size then see

e “ Hard Disk Size Note (Foam Rubber Insert)” on page6 - 7.
quired to install your oper-
ating system and
programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

6 - 4 Upgrading the Hard Disk Drive



Removing the Hard Disk

Turn off the computer, and turn it over and remove the battery (see page 6 - 3).

1.

2.
3.
4

Remove the screws @ & @.
Lift the hard disk bay cover up from point @
Remove hard disk bay cover @.

Upgrading The Computer

Figure6 - 2
Hard Disk Bay
Cover Removal

Upgrading the Hard Disk Drive 6 - 5



Upgrading The Computer

5. Slide the HDD assembly in the direction of arrow @.
6. Remove the HDD assembly @.
7. Remove the screw(s) @ - @ and the adhesive cover @.

Figure6- 3
Hard Disk Assembly
Removal 6

8. Reverse the process to install a new hard disk drive.
9. Replace the hard disk bay cover and screws.

6 - 6 Upgrading the Hard Disk Drive
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Hard Disk Size Note (Foam Rubber Insert)

Note that the hard disks pictured on the preceding pages are 9.5mm(H) hard disk
drives. In some cases 7mm(H) hard disk drives will beinstalled. For more informa-
tion contact your distributor/supplier, and bear in mind your warranty terms.

Figure6-4
Foam Rubber Insert
for 7mm(H) HDDs

* If you are replacing a 9.5mm(H) HDD with a 7mm(H) HDD then insert the
foam rubber insert (as shown above).

» If you arereplacing a 7mm(H) HDD with a 9.5mm(H) HDD then remove the
foam rubber insert.

.|
Upgrading the Hard Disk Drive 6 - 7
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Upgrading the Optical (CD/DVD) Device

The procedure for removing the optical device will depend upon your particular
computer model:

» See"Upgrading the Optical (CD/DVD) Device for Model A Computers’ on
page 6 - 8.

» See“Upgrading the Optical (CD/DVD) Device for Model B Computers’ on
page6 - 11.

.|
6 - 8 Upgrading the Optical (CD/DVD) Device
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Upgrading the Optical (CD/DVD) Device for Model A Computers

1. Turn off the computer, and turn it over and remove the battery (see page 6 - 3).
2. Locate the component bay cover and remove screws 0 - e
3. Remove the component bay cover e

o
(2
© Figure6-5
Removing the
9 Component Bay

Cover (Model A)

Upgrading the Optical (CD/DVD) Device 6 - 9
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4. Remove the screw at point @@, and use a screwdriver to carefully push out the
optical device at point @.

b Figure6- 6 (6]

Removing the
Optical Device
Drive (Model A)

5. Reverse the process to install the new device.
6. Replace the component bay cover and screws (see page 6 - 8).

6 - 10 Upgrading the Optical (CD/DVD) Device
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Upgrading the Optical (CD/DVD) Device for Model B Computers

1. Turn off the computer, and turn it over and remove the battery (see page 6 - 3) and
hard disk drive (see page 6 - 4).

2.  Remove the screw at point 0 and use a screwdriver to carefully push out the
optical device at point @.

3. Reverse the process to install the new device.

Figure6-7 a

Removing the
Optical Device
o Drive (Model B)

Upgrading the Optical (CD/DVD) Device 6 - 11
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDR3L type memory modules (see“Memory” on page D - 2 for details of
supported module types).

1. Turn off the computer, and turn it over and remove the battery (see page 6 - 3).

2. Locate the component bay cover and remove screws @ - 0.
3. Remove the component bay cover @.

e o

(3]

Figure6- 8
Removing the 9
Component Bay
Cover

6 - 12 Upgrading the System Memory (RAM)
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4. The memory sockets are visible at point 0
Figure6-9

RAM Module
Location

ZAS

Contact Warning

Be careful not to touch
5. Gently pull the two release latches on the sides of the memory socket in the the metal pins on the

direction indicated by the arrows (@ & @) in Figure 6 - 9. module’s  connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s

performance.
o © Figure6 - 10
RAM Module

Release Latches

Upgrading the System Memory (RAM) 6 - 13
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6. The RAM module will @) pop-up, and you can remove it.

4

Single Memory
Module Installation

If your computer has a sin-
FigureG -11 gle memory module, then
RAM Module insert the module into the @
Channel 0 (JDIMM1)
socket. In this case this is
the lower memory socket
(the socket closest to the
mainboard).

Removal

N

Pull the latches to release the second module if necessary.

8. Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

9. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

11. Replace the component bay cover.

.|
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Chapter 7: Modules & Options %

/ \Y

i Wireless Device
OverVIGW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please RS EEA T
contact your service representative. electronic transmission

» PC CameraModule * Intel® Rapid Start Technology iewﬁzﬁaﬁ:,) °""[,‘fo§f,ﬁ;‘if
* WirelessLAN Module Driver Make sure the WLAN &
* Bluetooth & WLAN Combo Module « Wireless Display Bluetooth  module(s)
* Trusted Platform Module « 3G Module are OFF (or the system

. is in Airplane Mode) if
* Intel® Rapid Storage Technology you are using the com-

puter aboard aircraft
(see

)-

. |
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7 - 2 Overview

\ A/
2§
Important Notice
If your purchase option includes both Wireless LAN and 3G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance

requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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PC Camera Module

Note that you need to use the Camer a app in Windows to take pictures and capture
video. Usethe Fn + F10 key combination (see“ Function/Hot Key | ndicators’ on
page 1 - 13) to toggle power to the PC Camera module. When the PC Camerais
in use the LED indicator to the left of the camerawill be illuminated in red (see @
Figurel-2onpagel- 7/[Figurel- 3 on pagel- 8).

. |
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PC Camera Audio Setup

If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Goto the Control Panel.

2. Click Sound (Hardware and Sound) and click Recording (tab).

3. Right-click hold and release Microphone (Realtek High Definition Audio) and
make sure the item is not disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

6. Click OK and close the control panels.

Figure 7- 1
Audio Setup for PC Playback | Recording | Sounds | Communications

General | Listen | Levels | MicArray | Advanced

o~

Select a recording device below to modify its settings:

= 0 | 76 [

Microphone ;
Realte S
i D Configure Speech Recognition
Disable
Microphene Boost
Show Disabled Devices [0a

. . Show Discennected Devices
ight-cli -k

Microphone

Camera

i

Properties

Configure Set Default [ Properties

7 - 4 PC Camera Module
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Camera App

1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. The camera interface will display two buttons on the right side of the screen. .
! Wi clspiay N 9Nt S Figure7-2

Camera App
Buttons

4

Exposure

Use the slider to adjust
the Exposure level.

3. The upper button is used to record video, and the lower button is used
to take still pictures.

Right-click on the screen to bring up menu buttons at the bottom of the screen.
These buttons enable you to access the camera roll (where captured pictures and
video are displayed), set the timer (the time period before capture begins; 3
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain

the best results.
Figure7-3
Camera Options

Camera roll

ok

Timer Exposure

PC Camera Module 7 - 5
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Camera Options
The Camera Options settings may be accessed as follows:
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. While the camera app is running access the Charms Bar (e.g. click Use the
Windows logo key == + D key combination).

3. Click Settings and then click Options.

4. You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid
lines and turn Location Info on or off from the Options panel.

Figure7-4
Camera Options

7 - 6 PC Camera Module
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Taking Pictures/Capturing Video
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. Right-click the screen and select the timer if you require a countdown before
capture.

3. Click the appropriate icon to take a picture or start video capture (if video capture

begins a timer will appear in the bottom corner of the screen).

To stop video capture click the main window again (or click the stop icon ).

Captured photos and videos will be saved to a Camera Roll folder within the

Pictures folder.

ok

Figure7-5
Pictures - Camera
Roll

PC Camera Module 7 - 7



Modules & Options

Camera Roll
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. Right-click on the screen to bring up menu buttons at the bottom of the screen.

3. Click Camera Roll.

4. Click the arrows - / -(on either side of the screen) to browse through the
captured photos/video, and back to the Camera app.

Editing Photos

Figure7- 6 1. Clicking on a captured photo will bring up an app bar with a series of buttons.

Edit Buttons

(for Still Photos)
2. The Camera butt ton will take you back to the home screen of the camera app.
3. Click Delete to remove any photo from the camera roll (you will be asked to click
Delete again to confirm the deletion).

4. The Open With butt ton will allow you to select a program with which to open the
photo.
You can click Set as Lock screen to set the photo as the lock screen picture.
Clicking Slide Show will create a slide show of photos/video in the camera roll.
Click Rotate to rotate the picture through 90 degrees.
Use the handles to Crop any captured picture, and click Apply to make the
changes (you can change the Aspect ratio by clicking the button and selecting an
aspect ratio from the menu). You can Save a copy (create another copy of the

©NOo O

. |
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photo with the edited changes), Update original (which changes the original

picture permanently) or Undo any changes.

9. Click the Edit button to bring up a full suite of tools to edit the photo.
10. Click on the menu headings on the left, and then click on the tool on the right to

edit the photo as required.
Edit Menu Basic Fixes Light

Q

Rotate

Retouch

Color Effects

%t

Temperature

Figure7-7
Editing Tools

Saturation

Q

Color enhance

11. After the editing process is completed right-click on the photo to Save a copy
(create another copy of the photo with the edited changes), Update original
(which changes the original picture permanently), Undo any changes or Cancel

the editing.

PC Camera Module 7 - 9
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Figure7-8
Edit Buttons
(for Video)

Figure7-9
Trim Video
(for Video Files)

Editing Photos

1.

»

Clicking on a captured video will bring up an app bar with a series of buttons.

Trim

Click Delete to remove any video from the camera roll (you will be asked to click
Delete again to confirm the deletion).

The Open With butt ton will allow you to select a program with which to run the
Video.

Clicking Slide Show will create a slide show of photos/video in the camera roll.
Click Trim to edit the video. Use the round buttons at either end of the slider to
adjust the video length and click Save a copy to save the changes made.

Click to select and move the rounded buttonsto edit the video.

. |
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Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video fileto a
location other than the C: drive.

PC Camera Module 7 - 11
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Wireless LAN Module

N If you haveincluded an I ntel® or 3rd Party WL AN modulein your purchase option
Spciiden Ay mak_e surethai_t the moduleison (i.e. the systemisnot in Airplane Mode) before in-
Aircraft stalling the driver.

2MN\Z
R

IR c SRl Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3.
electronic transmission

devices aboard aircraft
is usually prohibited.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
Ve ANl & Bluetooth Combo modules.

Bluetooth module(s)

are OFF if you are using

the computer aboard

aircraft by putting the

system in to Airplane

Mode (see

).
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3rd Party 802.11b/g/n Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click L.Install WLAN Driver > Yes.

Click Next.

Click Finish to restart the computer.

The operating system is the default setting for Wireless LAN control in
Windows (see page 7 - 14).

OO0k wWN

Intel® WLAN Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,

and then insert the Device Drivers & Utilities + User’s Manual disc into

the DVD drive.

Click Option Drivers (button).

Click L.Install WLAN Driver > Yes.

ICIi;gJiln the tickbox to agree to the End User License Agreement and click
nstall.

Click Finish.

The operating system is the default setting for Wireless LAN control in

Windows (see page 7 - 14).

ou AWN

. |
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WLAN Configuration in Windows

Y ou can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).

3. Alist of available access points will appear.

(© Networks
. b 4 I‘ ,) * Airplane mode
Figure7-10 ‘ off
WiFi Settings Available &7 Brightness
(Charms Bar) & -
Networks

On

E d) .Illl CPhone

Motifications Power Keyboard

all RDT13-ASUS-RTe6U-2....

all RD113
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4. Double-click an access point to connect to it (or click it and click Connect).

5. Enter a network security key (password) if required, and click Next.

6. You can choose to find other devices or not.

7. When you are connected to the network access point it will display Connected
[Connected |

8.

Select any connected network and click Disconnect to disconnect from a
connected access point.

(© Networks (© Networks

Airplane mode Airplane mode

Off

Figure7-11
Networks
Connected /
Disconnect

On

.llll CPhone

RD113-ASUS-RTE6U-2....
il

al RD113

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On
or Off.

10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.

Wireless LAN Module 7 - 15



Modules & Options

Figure7-12
Windows Desktop
Taskbar Notification
Area WLAN
Connection

Desktop Mode

1.

Nogk~wd

Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

Click the wireless icon [#lll in the notification area of the taskbar.

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to find other devices or not.

Select any connected network and click Disconnect to disconnect from a
connected access point.

(®© Networks

Airplane mode

(© Networks off

Airplane mode

On

.Illl CPhone

RDT13-ASUS-RT66U-2....
all

| RD113
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Bluetooth & WLAN Combo Module ¢
Wireless Device

Operation Aboard
Aircraft

If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

Make sure that the module ison (i.e. the systemis not in Airplane M ode) before in-

stalling the driver. The use of any portable
electronic transmission

devices aboard aircraft
is usually prohibited.

4
Bluetooth Data Transfer Make sure the WEAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane

Mode (see

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).
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Modules & Options

4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.

3rd Party Bluetooth (V4.0) Combo Driver Installation

1.

ok wN

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’'s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next.

Click Finish to restart the computer.

See “ Bluetooth Configuration in Windows” on page 7 - 19 for configura-
tion instructions.

Intel Bluetooth Combo Driver Installation

1.

Noakrwd

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the tickbox to accept the license and click Next.

Click Next > Finish.

See “Bluetooth Configuration in Windows” on page 7 - 19 for configura-
tion instructions,

7 - 18 Bluetooth & WLAN Combo Module
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Bluetooth Configuration in Windows ™
Y ou can configure a Bluetooth connection as below, however make sure the Blue- 7£l<

tooth module is on (or the system is not in Airplane Mode) before configuration. Bluetooth Headset
Stereo Setup

Desktop Mode

1. Switch to the Windows Desktop (click the App or use the Windows logo key 2@ + To setup a Bluetooth
D key combination). headset_ to support ste-

2. Click the notification area of the taskbar and double-click the Bluetooth icon [l (or [ EEREEER e S
click and select Show Bluetooth Devices).

3. The Bluetooth item in PC and Devices will appear.
OR

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click Change PC Settings.

3. Select the Bluetooth item in PC and Devices.

O E -jc}j- Figure7 - 13

Available Brightness Bluetooth Taskbar
Icon & Change PC
=] Settings (Charms

Bar -Settings)

Notifications Keyboard

( > Change PC settings
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4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.
5. Double-click the device you want to pair with the computer and click Pair.

Figure7- 14

PC and Devices -
Bluetooth
6. On first connection the computer will provide you with a pairing code to be entered
onto the device.
Figure7 - 15

Enter the Passcode

7. Enter the code into your Bluetooth enabled device and click Yes on the computer
to complete the pairing.
8. Select a device and click Remove Device to disconnect from any device.
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To Make your Computer Discoverable to Bluetooth Devices

1. Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

2. Click the notification area of the taskbar, click the Bluetooth icon and click
Open Settings.

3. Click Options, and make sure that Allow Bluetooth devices to find this
computer check box (Discovery) has a tick inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Connections) has a tick inside it, if you want to be notified when a
Bluetooth device wants to connect.

Figure7 - 16
Bluetooth Settings
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Trusted Platform Module

The TPM security chip alowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organi zations, and therefore requires implementation by asys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. aUSB flash drive) to stor e passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.

7 - 22 Trusted Platform Module



Modules & Options

Enabling & Activating TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu.

Select TPM Configuration and press Enter to access the sub-menu.

Press Enter to access the TPM Support menu and select Enable to display the
full TPM configuration menu.

Select TPM State, press Enter and select Enabled to change the TPM state to
enabled. You will then need to press F4 to save the changes and restart the
computer.

agrwnE

o

Bptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

TPM SUPPORT

Figure7- 17
TPM State
(Enabled)

7. As the computer restarts press F2 to enter the BIOS again and go to the TPM
Configuration menu.

. |
Trusted Platform Module 7 - 23



Modules & Options

8. Select Pending operation, press Enter and select the option you require (if you
are initializing TPM you should select Enable Take Ownership and press Enter).
You will then need to press F4 to save the changes and restart the computer.

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Pending operation [Hone]
Figure7 - 18
Pending TPM
operation
(Enable Take Pending TPM operation
OWnerShip) g:':f:le Take Ownership

Disable Take Ownership
TPM Clear

9. You can now install the TPM driver (see “Trusted Platform Module (TPM)
Driver Installation” on page 7 - 25) and then initialize the TPM.

. |
7 - 24 Trusted Platform Module



Modules & Options

Trusted Platform Module (TPM) Driver Installation

1. Make sure you have enabled and activated the TPM in the BIOS before
installing the driver.

Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 3.Install TPM Driver > Yes.

Click Next.

Click the button to accept the license and click Next.

Click Next > Next > Install.

Click Finish > Yesto restart the compuiter.

N

N AW

. |
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Initializing TPM

1. Switch to the Desktop app and click the TPM icon right-click the icon in the
notification area of the taskbar, and select Security Platform Initialization (or
click the Security Platform State taskbar bubble). TEM

2. Click User Settings (tab) and click Yes, or right-click the icon Zi} in the
notification area of the taskbar, and select Security Platform Initialization (or
click the Security Platform State taskbar bubble).

3. The Quick Initialization method will automatically be selected for you (if you need
to use advanced settings provided by your network administrator then select
Advanced Initialization).

4. You will need to use a removable media (e.g. a USB Flash Drive) to store
passwords and data (keep the media in a safe place until required).

5. Select the drive you want to use from the drop-down menu and click Next.

Figure7-19
Security Platform
Quick Initialization

Wizard
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6. Choose the Security Platform Features you want to use by clicking the
appropriate tickbox. /
7. Enter a Basic User Password (and re-type to confirm it) and click Next.

Help
Settings nght—cl_l(?k the icon in
Configure Security Platform Settings the notification area of the
taskbar to bring up the menu
Which Security Platform Features do you want to use? to select Hel p or How to use
the Security Platform Fea-
[ Hardware-based Encrypting File System (EFS) tures.

[“]Personal Secure Drive (PSD)

Size: a ME Drive letter:

Please set your Basic User Password, This password will protect your Basic User Key which is reguired to
use Security Platform Features.

sessnnes [w] Hide typing

Confirm password:

Use different passwords for different purposes.
Length: 6 ... 256 characters.

You can also click the Help
button in any of the Infineon

— cns rep Security Platform  Settings
. . . Tool tabs to bring up specific
8. Click Next to confirm the settings. help topics on each tab.

9. The computer will then initialize the settings.

10. Click Finish.

11. Click the tabs and control panels to adjust the settings. Figure7 - 20

12. Double-click the icon in the taskbar notification area to access the Infineon
Security Platform Settings Tool, or right-click the icon and select a menu
item.

Settings
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Infineon Security Platform Settings Tool

e The Infineon Security Platform Settings Tool allows you to manage and check the
TPM state, manage your password information, and to backup and restore the TPM
data. As TPM is usually administered within large enterprises and organizations,

Note that not all the .. . . . . . .
menus pictured here will | YOUr System administrator will need to assist you in managing the information here.

be available for access.
The menu items that ap-
pear will be dependent on
your configuration set-
tings etc. (see the Help
file for full details).

Menus

Figure7-21
Infineon Security
Platform Settings

Tool

. |
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This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure se-
cure e-mail, file and folder encryption and Enhanced Authentication. You can also
import or delete certificates protected by the security platform.

i Infineon Security Platform Settings Tool

Basic User Password

Security Platform Features

Configure...

Security Platform Certificates

Manage...

Info | User Settings | Backup | Migration | Password Reset

Change your Basic User Password. This

password is required to access Security Platform

keys and certificates.

Configure secure e-mail, flle and folder
encryption.

iew, import or delete Security Platform
certificates.

Close

Help

Figure7 - 22
Infineon Security
Platform Settings

Tool (User Settings)
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Backup

Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restora-

tion.
Info User Settings : Backup | Migration | Password Reset
. Security Platform Backup
Figure7 - 23
H H Backup and Restore Security Platform credentials, Security Platform settings and

I nfl neon Secu rlty Personal Secure Drives,
PI atfo rm Sett n g S System backups (administrative tasks)

TO 0 I (B ac k u p) T Setup automatic system backups for all users.

Tee I Restore from a system backup.

Manual badwps {for the current user)

Restore... Restore from a manual backup.
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

| Password Reset|

Credentials migration involves securely copying and transferring user security
credentials from a source platform to a destination platform. Based on the platform
wou are on, different actions need to be performed.

Figure7-24
Learn more. .. | For a detailed description and step by step guide |nf| neon Secu |‘|ty
— for credentials migration, dick "Learn more”, .
Platform Settings
Tool (Migration)

(®) This is the source platform

() This is the destination platform

Source Platform Actions

Export user keys and certificates to a destination
Export...
=xpor platform.

Authorize credentials migration to a destination

Authorize...
rm.
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Password Reset
Use Password Reset to reset basic user passwords when required.

Configure and enable

Administrative Task

Configure. .. Create Password Reset Token for all users,

F|gure 7-25 Current State:  [Configured. ﬂ¢
Infineon Security
Platform Settings

7 Tool Enable Password Reset for current user.
(Password Reset) Current State:  Enabled. %/

User Task

Reset Basic User Password

Administrative Task

Prepare and provide the Password Reset Authorization Code
for a spedfic user. Prepare and reset for the current
administrator account in one step.

Prepare...

User Task

Reset my password {Password Reset is already prepared for
= my user account).
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitL ocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

Info | User Settings | Backup | Migration | Password Reset | Bitlocker | Advanced

‘You can use BitLocker Drive Encryption together with the Trusted Platform Madule

to encrypt data on your disk. F| gure 7 _ 26
Infineon Security
Platform Settings
Current state: rwotoonﬁgured . Tool
(BitLocker)

. |
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Access the Microsoft BitLocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

e x
T

® ~ 4 e » ControlPanel » System and Security » BitLacker Drive Encryption v ¢ | | Search Control Panel r)

Control Panel Home

BitLocker Drive Encryption

Help protect your files and folders from unauthorized access by protecting your drives with BitLocker.

Operating system drive

Figure 7-27 SYSTEM (C) BitLocker off *
BltLOCker Drlve =..==,'- & Turn on Bitlocker
Encryption -
Fixed data drives
DATA (F) BitLocker off ~

Removable data drives - BitLocker To Go

RC FLASH (DY) BitLocker off O]

See also
) TPM Administration
) Disk Management

Privacy statement
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

|Ir1Fo IUser Settings I Backup |Migraﬁor1 Password Reset | BitLocker | Advanced

Owner Password

Change the password for critical administrative

Security Platform tasks.
Figure7 - 28
Security Platform Features Infineon Security
Configure... Resct Exhonced Authemscoton and Dciarary Platform Settings
Attack Defense settings. TO 0 |
(Advanced)

Security Platform State

Disable Security Platform operation.
Disable...

Reset... Reset dictionary attack defense level.

Security Polides

System... Configure the local security policies for your
system.

Configure user specific local security policies.

Close | | Help

Trusted Platform Module 7 - 35



Modules & Options

Intel® Rapid Storage Technology

Install the Intel® Rapid Storage Technology to support your AHCI mode SATA
drive.

IRST Driver Installation

1

ONOUAWDN

Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 4.Install IRST Driver > Yes.

Click Next.

Click in the tickbox to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the Start screen.

.|
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Intel® Rapid Start Technology Driver

Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to
6 seconds and can remember your computer's previous state with zero power.

Wstem Requirementsto support Intel® Rapid Start Technology:
Rapid Start Technology should be enabled in the BIOS (see “* Intel (R) Rapid
Sart Technology (Advanced Menu)” on page5 - 7).

» Intel Rapid Storage Technology software installed (see” Intel® Rapid Storage
Technology” on page 7 - 36).

* A Solid State Drive (SSD) with a minimum capacity of 18.6GB.

» The Solid State Drive (not the HDD) must be configured as outlined on the fol-
lowing pages to support Rapid Start Technology.

» The Windows operating system must be installed on the system hard disk drive,
and not on the Solid State Drive (SSD).

AN
I

Operating System Installation

Note that in order for Intel(R) Rapid Start Technology to function properly the Windows
operating system must be installed on the system hard disk drive (e.g. the “C:” drive), and
the SSD should be configured as outlined on the following pages. Rapid Start will not func-
tion if the operating system is installed on the SSD.

See overleaf for instructions on enabling Intel® Rapid Start Technology.
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Intel® Rapid Start Technology Configuration

1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R)
Rapid Start Technology (Advanced Menu)” on page 5 - 7).

2. Go the Windows control panel and double-click Administrative Tools (System
and Security)> Computer Management > Storage > Disk Management

3. Right-click the SSD and select Shrink Volume from the menu.

7 Figure7-29
Computer
Management

(Shrink SSD
Volume)

C "y Shrink Volume
\—J

.|
7 - 38 Intel® Rapid Start Technology Driver



Modules & Options

4. Enter the figure, which should be equal to amount of system memory (RAM)
in your computer, in “Enter the amount of space to shrink in MB”.

| <l - Figure7 - 30
Shrink Volume
Size

5. Click Shrink (any unallocated file space may be formatted for storage use).

4

Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB

(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be dis-

played in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6. Run the Desktop app and right-click the lower left hot corner (or use the Windows
Logo Key == + X key combination) and select Command Prompt (Admin).

Programs and Features
Mobility Center

Power Options

Event Viewer

System

Device Manager

Flgure 7 = 31 Disk Management
Search for CMD o e
Prompt

ommand Prompt (Admin]

Task Manager

Control Panel

File Explorer
Search
Run

Desktop

7. Type “DISKPART".
8. Atthe DISKPART command type “list disk”.

Figure7 - 32
Diskpart - List Disk
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9. Type “select disk #” (# is disk number where you want to create the store partition,
so refer to the results obtained from "list disk" for exact disk number).
10. The message “Disk # is now the selected disk.” will appeatr.

Figure7 - 33
Diskpart - Select
Disk #
11. Type “create partition primary”.
12. A “DiskPart succeeded in creating the specified partition.” message should
appear. .
Figure7-34
DISKPART > create partition primary Diskpart - Create
Partition

DizkPart succeeded in creating the specified partition.

DISKPART > _
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13. Type “detail disk”.

Figure7 - 35
Diskpart - Detail
Disk
14. Type “select Volume #” (# is volume of your storage partition so refer to results
obtained from "detail disk" for the exact volume number).
15. The message “Volume # is now the selected volume.” will appear.
Figure7 - 36
Diskpart - Select
Volume #
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16. Type the following, depending on the format of the SSD.

* For MBR formatted SSDs. “set id=84 override’ (the id must be set to 84).
» For GPT formatted SSDs. “set id=D3BFE2DE-3DAF-11DF-BA40-E3A556D89593".

Figure7 - 37
Diskpart - Set id=

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.
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Figure7 - 38
Computer
Management
(Healthy
Hibernation
Partition)

19.

20.

21.
22.

Go the Windows control panel and double-click Administrative Tools (System
and Security)> Computer Management > Storage > Disk Management.
The disk partition should read Healthy Hibernation Partition.

g m | e
298..09 GB 100 MB NTI || 102,68 GB NTFS
Online Healthy (Sy | Healthy (Boot, Pacg

= Disk 1 I
Basic

18,67 GB 1067 GB 4.00 GB
Online ILi=althy (Hibernation Partition)ly

Healthy (Hibernation Partition)

== Disk 2 |

= ISR N A R T LR

Restart the computer.
Install the driver (see below).

Intel® Rapid Start Technology Driver Installation

1.

agrowN

Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 5.Install Rapid Sart Driver > Yes.

Click Next > Next > Yes > Next > Next.

Click Finish to restart the computer.
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Wireless Display

WirelessDisplay (requiresan Intel® 7260 and 3160 series WL AN/Combo mod- /_
ule), in conjunction with a compatible video adapter/display device (purchased Compatible
separately), allows you to display the contents of the notebook display on another Adapters

display (e.g. HDTV) without the need to have cables stretching acrossaroom. You | For a list of compatible
can then play games, browse the internet, display videos or photo slide shows on | display and audio adapt-
your TV/external display without using HDMI or A/V cables. ers check the Intel web-

site, or your distributor/

lier.
Before configuring Wireless Display you will need to set up your compatible SHPPIET

adapter with your display/speakers. Connect the adapter usingan HDMI or A/V ca
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.
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Wireless Display Configuration

Note that no driver or application is required for wireless display in Windows 8.1.
Go the Charms Bar, select Devices.

Click Project.

Click Add a wireless display.

PR

Figure7 - 39
Add a Wireless
Display
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5. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

Figure7 - 40

Searching For
J Devices

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are
connecting.
8. Click Next.
Figure7-41
Enter PIN

.|
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9. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

10. To disconnect from the display you can select it in PC and Devices > Devices and
click Remove Device > Yes; or go to the Project menu (Charms Bar > Devices)
and click Disconnect.

Figure7 - 42

Remove Device/ < >

Disconnect

>

Remove device
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3G Module .

AV N2
If you have included an optional UM T S/H SPA+ based 3G Module (Universal Mo- /Q\

. .. . “ Wireless Device
bile Telecommuni cations System or High Speed Packet A ccess) module (see” Com- Spciiden Ay

munication” on page D - 3 for specification details) in your purchase option, you Aiiera

do not require a driver/application installation for Windows 8. Follow the instruc-

tions overleaf to install the USIM card (which will be provided by your service pro- Zlitfjsl . ' ﬁgﬁsﬁ’gigﬁ

vider), and then use the Charms Bar Wirelessicon to access the 3G network in B el e

the same manner asthe WLAN (see page 7 - 51). is usually prohibited.

Make sure the WLAN &

2N\ Bluetooth module(s
'Q\ are OFF if you are usi(ng)

Important Notice the computer aboard

aircraft by putting the

system in to Airplane

Mode (see

If your purchase option includes both Wireless LAN and 3G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance
requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.

).

Important Notice - 3G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 3G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.
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3G Module USIM Card Installation

Ny . . . . . .
A Follow the instructions below to install the USIM card (which will be provided by
Power Safety your service provider).
Warnin .
g 1. Turn off the computer, and turn it over.
Before you undertake any 2. Slide the latch @ in the direction of the arrow.
QBB RSl 3. Slide the latch @ in the direction of the arrow, and hold it in place.
make sure that you have 4 Remove the batte 9
turned off the power, and ! ry ' .
disconnected all peripher- 5. Insert the_U_SII\_/I card e (at the rear of the battery compartment) as illustrated
als and cables (including below until it clicks fully into position, and replace the battery.
telephone lines). It is advis-
able to also remove your
battery in order to prevent 9 0
accidentally turning the ma- e
chine on.
USIM Card Orientation
Note that the USIM card’s
readable side (with the
gold-colored contacts)
should face upwards as il-
lustrated.
Figure7-43 (1)

Battery Removal &
USIM Card Insertion
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3G Configuration in Windows

Y ou can configure a 3G connection as below, however make sure the system is not
in Airplane Mode before configuration begins.

Charms Bar

1. Go to the Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).

3. Alist of available access points will appear under Mobile Broadband.

1) -0-
Available ; 67 Brightness Figure7 - 44 7

Networks
Mobile Broadband
2 O

Notifications Power Keyboard

Change PC settings
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4. Any 3G service provider (connection information is usually stored on the USIM
card) will appear under Mobile Broadband.

5. Double-click any connection icon under Mobile Broadband (or click and then click
Connect).

Figure7 - 45
Mobile Broadband
(Connect)

6. The system will connect to your network.
7. A Connected will appear alongside the 3G connection (click the connection to
view the timer which indicates your connected time for the current session).
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8. You can then access the internet, download e-mail etc. as per any internet -
connection. ﬂ(

9. To disconnect you can select the connection and click Disconnect [EZea]. Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.

Make sure the system is
in Airplane Mode if you
are using the computer
aboard aircraft.

Figure7 - 46
10. You need to either use Airplane Mode, or to turn the Mobile Broadband module Mobile Broadband
off aboard aircratft. (Disconnect)
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EM820W 3G Module PIN Code & Power-Saving

Note that there may be some issues when a PIN Code is set for the EM820W 3G
module (if you are unsure of your module version contact your distributor/supplier)
in Windows, if Mobile Broadband has been turned off, and the system has resumed
from apower-saving state. To prevent any issuesit isrecommended that you sim-
ply do not enablea PIN for the EM 820W 3G module. The following providesin-
structions for disabling the PIN code; for specific instructions on resolving the issue
where“Insert aSIM” appearsin the connection see“ Resolving the“ Insert a SIM”
issue with the 3G Module (Windows 8.1)” on page 8 - 17.

1. Gotothe Charms Bar.

. Disabling a PIN code for a 3G Module
7
2. Click Change PC Settings.

-

.9..

Lt )

* [ D]

Available 67 Brightness
Figure7 - 47
Change PC Settings

2 O

Notifications Power Keyboard

hange PC settings
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Click Network.

Click the broadband connection under Mobile Broadband.

Scroll down to Security and click Remove PIN.

Enter the current PIN number and click OK.

It is recommended that you do not Enable a PIN for the EM820W 3G module.

-

No oMW

Figure7 - 48
Disable PIN

-
-

8. Click Security (tab) and click Disable PIN.
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sureit is actually working. Check the LED Power & Communication Indicators (see” LED Indica-
tors’ on page 1 - 9) to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 7), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
Ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(thisis acommon cause of the message “I nvalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

* Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

» Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sureyou haveinstalled the driversfor any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ,is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/lUSB device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 14).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 18). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix C for instructions on installing and configuring
on. the video driver.

. |
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function/Hot Key Indicators” on page 1 - 13) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers when

typing.

appear

Num Lock is turned ON (see “Function/Hot Key Indicators” on page 1 - 13).
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Problem

Possible Cause - Solution

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Go to the Charms
Bar and select Settings and then click the WiFi icon (Airplane mode should be

Off).
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Problem

Possible Cause - Solution

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator (¢p) to see if itis in Airplane Mode (see “LED Indicators” on page 1
- 9). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see
Table 1 - 3, on page 1 - 13).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 13). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

| cannot obtain high speed Bluetooth data
transfer.

To obtain high speed Bluetooth data transfer take into account the following:

» Toachieve high speed transfer speeds, both devices must support high
speed data transfer (i.e both the computer and the Bluetooth compati-
ble device you are connecting to).

» Check your Bluetooth compatible device's documentation to confirm it
supports high speed data transfer, and for configuration information.
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Problem Possible Cause - Solution

| have used Update Driver in Device | Itis very important that the drivers are installed in the order indicated in Chapter
Manager (Unknown device > Other | 4 (which is the numbered installation order on the Device Drivers & Utilities +
Devices) to try and install the Airplane | User’'s Manual disc). This issue can occur when drivers are manually installed,
Mode driver. Windows encountered a | and not in the correct order.

problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

1. Go tothe Programs and Features (Programs) control panel in
Windows.

2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the
current driver.

3. Restart the computer.

4. Insert the Device Drivers & Utilities + User’'s Manual disc and click
Install Drivers (button).

5. Double-click the Airplane Driver item in the menu.

6. Follow the instructions to install the correct driver (you will need to
restart the computer as part of the installation process).

. |
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Problem Possible Cause - Solution

| have connected a Bluetooth Mouse but | This is an issue with some mouse models and the Intel Wireless 7260 WLAN
it loses the Bluetooth connection and | and Bluetooth combo module series. To resolve this issue do the following:
no longer responds after a short period of

inactivity. 1. Go to the Device Manager control panel in Windows.
2. Click the arrow alongside Bluetooth to expand the menu if required.
3. Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
4. Click the Power Management tab.
5. Make sure that the tickbox alongside “allow the computer to turn
off this device to save power” doesn’t have a tick alongside it.
6. Click OK and close the control panel.

Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter Prope... |

General | Advanced | Driver | Details E\rerrt

9 Intel{R) Wirsless Blustocth(R) 4.0 = H5 Adapter

QG

low the computer to tum off this device to save power:

Figure 8 - 1 - Device Manager (Bluetooth)
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Problem Possible Cause - Solution

When using a Bluetooth headset the | This is a common issue with Bluetooth headsets. To resolve this issue do the
audio appears to be mono and not | following (you will need to repeat this procedure after every boot up, restart,
stereo. or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device
(the default device is Headset).

Click Connect to complete the stereo connection.

NEOWDNE
Py}
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EM820W 3G Module PIN Code & Power-Saving

Note that there may be some issues when a PIN Code is set for the EM820W 3G module (if you are unsure of
your module version contact your distributor/supplier) in Windows, if Mobile Broadband has been turned off,
and the system has resumed from a power-saving state. To prevent any issues it is recommended that you
simply do not enable a PIN for the EM820W 3G module. The following provides instructions for disabling
the PIN code.

Disabling a PIN code for a 3G Module

1. Gotothe Charms Bar.
2. Click Change PC Settings.

* i) {c}}
67

Available Brightness

2 o

Notifications Power Keyboard

Change PC settings )

Figure 8 - 2 - Change PC Settings
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Click Network.

Click the broadband connection under Mobile Broadband.

Scroll down to Security and click Remove PIN.

Enter the current PIN number and click OK.

It is recommended that you do not Enable a PIN for the EM820W 3G module.

-

No oMW

-
-

Figure 8 - 3 - Disable PIN
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Resolving the “Insert a SIM” issue with the 3G Module (Windows 8.1)

1. IfaPIN was set for the EM820W 3G module, you have then switched Mobile broadband off (or put the system
in Airplane Mode) in Networks, and the system has just resumed from a power-saving state the following error
may occur.

On resuming from the power-saving state the standard procedure would be to go to Networks in the Charms
Bar and turn on Mobile broadband.

Go to the Charms Bar.

Select Settings and you will then note that the WiFi icon will read Unavailable.

Standard procedure would be to click the connection and enter the PIN number to unlock the connection.

In this instance you will note that the Mobile broadband connection will read Insert a SIM.

In this case you will need to restart the computer.

After system restart you can then connect to the Mobile Broadband as normal.

To fully resolve this issue it is recommended that you do not Enable a PIN for the EM820W 3G module.

n
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.
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Item Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into

USB 3.0 Port the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
350 comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB
3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.
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Appendix B: Control Center

Overview

Thefollowing chapter will give aquick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down
and move the dlider where applicable. Certain functions will automatically be adjusted when a power mode is
selected. The Control Center in Windows 8.1 works under the Desktop app and not under the Start screen.

Figure B - 1 - Control Center
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power

mode will affect screen brightness, Touchpad and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off the Touchpad and PC camera.

. . . r
Modes Power Saving Entertainment Quiet Performance Us_e
Defined
Icon & '
L3
Power Plan Power Saver Power Saving Power Saving High Performance
Power Conservation Mode Energy Star Energy Star Energy Star Performance
@
Brightness 10 100 40 100 1]
g
=
PC Camera OFF OFF ON ON e
B TouchPad ON ON ON ON

Table B - 1- Power Modes

. |
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Power Status
The Power Statusicon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness

The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again). Note that screen brightness is also effected by the Power M ode selected (see
TableB - 1, on page B - 2).

Volume
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Power Conservation

This system supports Ener gy Star power management features that place computers (CPU, hard drive, etc.) into
alow-power sleep modes after a designated period of inactivity (see“ Power Conservation Modes’ on page 3 -
12). Click either the Perfor mance, Balanced or Energy Star button.

. |
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Sleep
Click the Sleep button to bring up the Hiber nate or Sleep buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “ Power-Saving States” on page 3 - 7).

Display Switch
Click the Display Switch button to access the menu (or use the §g@ + P key combination) and select the appro-
priate attached display mode (see page C - 18).

Time Zone
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background
Clicking the Desktop Background button will alow you to change the desktop background picture.

TouchPad/PC Camera

Click either of these buttons to toggle the TouchPad or camera module’s power status. A crossed out icon will
appear over the top left of the icon when it is off. Note that the power status of the camera module is also
effected by the Power Mode selected (see Table B - 1, on page B - 2).

Caps Lock/Scroll Lock/ Number Lock 8 & &
Click the button to toggle the appropriate lock mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
page1 - 31.

Video Driver Installation

Make sureyou install the driversin the order indicated in Table 4 - 1, on page 4 - 3.

1. Insertthe Device Drivers & Utilities+ User’s Manual disc and click I nstall
Drivers (button).

2. Click 2.Install VGA Driver > Yes.

3. Click Next > Yes> Next > Next.

4. Click Finish to restart the computer.

Note: After installing the video driver go to the Display control panel to adjust the
video settings to the highest resolution.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically alocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must beinstalled). DVMT returns whatever memory is no longer needed to the op-
erating system.

. |
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Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
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Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel®@ HD Control Pan-
el. To access the control panel see below and overleaf:

1. Click the Intel® HD Graphics Control Panel icon in the Start screen.

FigureC-1
Start Screen
Intel® G&M Control
Panel

(see over)
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OR

2. Right-click the Desktop and select Graphics Properties from the menu.

OR

3. Click Advanced settings in the Screen Resolution control panel in Windows.

4. Click the Intel(R) HD Graphics Control Panel tab and click Graphics Properties
(button).

5. Double-click the Intel(R) HD Graphics control panel in the Windows Control
Panel.

FigureC- 2
Intel® HD Graphics
Control Panel

D
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Y ou may make changesto any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings on the right.

FigureC- 3
Intel® HD Graphics
Control Panel
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Sub-Menus
Some of the menu panelswill also have sub-menus (in the top left corner of the menu
alongsidetheicon ) to display further configuration options.

FigureC-4
Intel® HD Graphics
Control Panel
Sub-Menus
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Display
Z \ Click either Display Settings or Color to make display adjustments, including con-
Multiple Display figuration for any attached external displays.
At least one other dis- —
play must be attached in S P

order to view multiple
display selection op-
tions.

FigureC-5
Intel® HD Graphics
Control Panel
Display Settings

C - 6 Intel® HD Graphics Control Panel



Video Driver Controls

Click the Display menu at the top of the screen to display the sub-menus. The M ul-
tiple Displays menu allows you to configure the display mode of any attached dis- Z
plays (see* Attaching Other Displays’ on page C - 16). Multiple Display

At least one other dis-

play must be attached in
order to view multiple
display selection op-
tions.

FigureC-6
Intel® HD Graphics
Control Panel
Display Settings -
Multiple Displays
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The Audio sub-menu allows you to configure the capability mode of any attached
displays if applicable (i.e. the attached display supports audio). Enable Audio

Without Video to keep audio on when the display blanks out for power saving pur-
pOSes.

FigureC-7
Intel® HD Graphics
Control Panel
Display Settings -
Audio
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3D

This menu allows you to choose how 3D images are displayed. Quality displaysthe
most detail, Balanced provides better computer performance with good quality and
Custom allows you to configure the Anisotropic Filtering, Vertical Sync and
Anti-Aliasing features to your preferences. Click Apply to save changes.

FigureC-8
Intel® HD Graphics
Control Panel 3D
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Options
Options alows you to Customize Hot Keys (for opening the application, rotating
the display, scaling etc.,) to your preferences. Click Apply to save changes.

FigureC-9
Intel® HD Graphics
Control Panel
Options
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-1n Display
and any attached displays.

Intel® HD Graphics Control Panel C - 11
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Preferences

Go to the Preferences
sub-menu in Options to
configure the preferenc-
es for the Intel® HD
Graphics Control Panel.

Make sure you turn Tray

Icon On to display the
Intel® HD Graphics
Control Panel icon in the
notification area of the
taskbar (as below).

FigureC- 10
Intel® HD Graphics
Control Panel
Options -
Information Center
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FigureC- 11
Intel® HD Graphics
Control Panel Video

(Basic - Driver

Settings)

Video

The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. Click Basic or Advanced to adjust the video settings based on the Ap-
plication Settingsor Driver Settings. The Preview image will display asampleim-
age using the current settings. You can Save Profile and name the Profile to recall
the settings at any time. Click Apply to save changes.
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction etc.Click Apply to save changes.

FigureC - 12
Intel® HD Graphics
Control Panel Video

Image
Enhancement Basic
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The Image Scaling and Gamut M apping menus alow you to adjust these items.

FigureC- 13
Intel® HD Graphics
Control Panel Video

Image Scaling &
Gamut Mapping
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Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or ex-
ternal monitor port. See your display device manual to see which formats are sup-
ported.

4
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.

Display Mode

(Intel / Win8) Description
; : One of the connected displays is used as the display device
Single Display (PC screen only or Second screen only). TableC-1

Display Modes
Both connected displays output the same view and may be play

Clone/Duplicate configured independently

Both connected displays are treated as separate devices, and

Extended / Extend act as a virtual desktop

Display Devices & Options C - 15
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4

Multiple Display

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

FigureC- 14
Display > Multiple
Displays (Clone)

Attaching Other Displays

To Clone Displays:

1.
2.
3.
4.
5.

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Intel(R) HD Graphics Control Panel control panel and click Display >
Multiple Displays (sub-menu).

Click Clone from the Select Multiple Display Mode menu.

Click Apply, and OK to confirm the settings change.

You can select the displays to be used from the Select Active Displays menu.

C - 16 Attaching Other Displays



To Enable Extended Mode:

1.
2.

3.
4,

Attaching Other Displays C - 17

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).

Click Extended from the Select Multiple Display Mode menu.

Click Apply, and OK to confirm the settings change.

Click the appropri-
ate monitor icon
and drag it to match
the physica ar-
rangement you
wish to use (e.g. the
secondary display
may be extended
left/right/above/be-
low the primary dis-
play).

Click Display Set-
tings to make any
adjustments re-
quired.

Video Driver Controls

4

Display Settings
Extended Desktop

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

FigureC- 15
Display > Multiple
Displays (Extended)
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4

Windows Logo Key
= + P Key
Combination

You can use the 58 + P
key combination to
quickly bring up the Sec-
ond Screen menu.

You can also use the
Display Switch &® but-
ton in the Control Cen-
ter to access the menu
and select the appropri-
ate attached display
mode.

You can also use the Fn
+F7 key combination to
quickly access the Sec-
ond Screen menu in
Windows 8.

FigureC- 16
Second Screen
(Devices)

Attaching Other Displays - Devices (Charms Bar)

Y ou can configure attached displays from Devices (in the Charms Bar).

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go the Charms Bar, select Devices.

Click Project (you may need to click Second Screen).

Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

PR
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Configuring an External Display In Windows

1.

2.
3.
4

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Screen resolution control panel (see page 1 - 35) in the Desktop app.
Click the Detect button.

The computer will then detect any attached displays.

FigureC - 17
Screen Resolution
Multiple Displays

Attaching Other Displays - Devices (Charms Bar) C - 19
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5. You can configure the displays from the Multiple Displays menu.

FigureC- 18
Screen Resolution
Multiple Display
Options

» Duplicate these displays - Shows an exact copy of the main display desktop on
the other display(s)
» Extend these displays - Treats both connected displays as separ ate devices
» Show desktop only on 1/2 - Only one of your displaysis used.

.|
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HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1.
2.
3.

Go to the Control Panel.

Click Sound  (Hardware and Sound) and click/ Playback (tab)

Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click/tap Set Default (button).
Double-click the device to access the control panel tabs illustrated overleaf.

4

Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

FigureC- 19
Sound - HDMI
Device (set Default)

HDMI Audio Configuration C - 21
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5. Adjust the HDMI settings from the control panel tabs.
6. Click/tap OK to close the Sound  control panel.

FigureC- 20
HDMI Device
Properties

C - 22 HDMI Audio Configuration
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HDMI Notes

» Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

» To play audio sources through your external display’s (TV or LCD) speakers
you will need to go to the audio configuration control panel on the display and
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out port to your external display.

2. Configure your external display as per the instructions in “Attaching Other
Displays” on page C - 16.

3. Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

4. You can now play video/audio sources through your external display.

HDMI Audio Configuration C - 23

4

Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).
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Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

.|
Specifications D - 1
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Intel® Core i7-4702MQ (2.2GHz)
Mobile Processor

6M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Core i7-4600M (2.9GHz)
Mobile Processor

4M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Core i5-4330M (2.8GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Core i5-4300M (2.6GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Core i5-4200M (2.5GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Core i3-4100M (2.5GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Core i3-4000M (2.4GHz)
Mobile Processor

3M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Pentium® 3550M (2.3GHz)
Mobile Processor

2M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Intel® Celeron® 2950M (2.0GHz)
Mobile Processor

2M L3 Cache, 22nm (22 Nanometer),
DDR3L-1600MHz, TDP 37W

Mobile Intel® HM86 Express Chipset

Model A:

14.0"/ 35.56cm HD (1366 * 768), 16:9
3.6mm thick Backlit Panel

Model B:

15.6"/ 39.62cm HD (1366 * 768) / FHD
(1920 * 1080), 16:9 3.8 / 3.4mm thick
Backlit Panel

Dual Channel DDR3L

Two 204 Pin SO-DIMM Sockets
Supporting DDR3L 1600 MHz Memory
Modules (real operational frequency
depends on the FSB of the processor)

Memory Expandable up to 16GB
Compatible with 2GB, 4GB or 8GB Modules

Intel® HD Graphics 4600

(GPU is Dependent on Processor):
Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7MB

Microsoft DirectX®11 Compatible

One Changeable 9.5mm(h) Super Multi/
Blu-ray Combo Optical Device Drive with
SATA Interface (Factory Option)

Dummy Optical Device Drive (Factory
Option)

See over
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One Changeable 2.5" / 9.5 mm (h) /
7mm(h) HDD with SATA (Serial) Interface

MSATA SSD (Solid State Drive) with
SATA (Serial) Interface (Factory Option)

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

Built-in Touchpad with Multi-Gesture
Functionality

Isolated A4 Size Keyboard (Model A)

Full Size Isolated Keyboard with Numeric
Pad (Model B)

Model A:
One USB 2.0 Port

Model B:
Two USB 2.0 Ports

All Models:

Two USB 3.0 Ports

One External Monitor Port

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

Embedded Multi-In-1 Card Reader

- MMC/ RS MMC

- SD/ Mini SD / SDHC/ SDXC

- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

Two Mini-Card Slots:

Slot 1 for Half Size Mini-Card WLAN
Combo Module with PCle & USB
Interfaces:

Slot 2 for Full Size Mini-Card 3G Module
with USB Interface

OR

Full Size Mini-Card mSATA SSD with
SATA Interface

Built-In 10/100/1000Mb Base-TX
Ethernet LAN

Intel® Wireless-N 7260 (2*2 802.11 b/g/n)
Half Mini-Card PCle WLAN + Bluetooth
Combo Module (Factory Option)

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module (Factory Option)

3rd Party Combo WLAN (802.11b/g/n)
and Bluetooth v4.0+LEHalf Mini-Card
Module with PCle Interface (Factory

Option)

1.0M or 2.0M HD Video Camera Module
with USB interface (Factory Option)
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UMTS/HSPDA OR UMTS/HSPDA+
based 3G Module with Mini-Card
Interface (Factory Option)

Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America

Supports Wake on LAN

Supports Wake on USB

Supports Wake on RTC Alarm (AC Mode
Only

Full Range AC/DC Adapter
AC input 100 - 240V, 50 - 60Hz,
DC Output 19V, 3.42A (65 Watts)

Removable 6 Cell Smart Lithium lon
Battery Pack 48.84WH

Removable 6 Cell Smart Lithium lon
Battery Pack 62.16WH (Factory Option)

D - 4 Specifications

LED Indicators - Power/Suspend,
Battery, HDD/ODD, Bluetooth/Wireless
LAN

One 48Mb SPI Flash ROM
AMI BIOS

Security (Kensington® Type) Lock Slot
BIOS Password

Model B Only:
Trusted Platform Module 1.2 (Factory
Option)

Painted Style (For some Model designs
in this series)

IMR (Injected Molded Resin) LCD Back
Covers for some Model Designs

Intel® Anti-Theft Technology

Intel® Rapid Start Technology

Windows® 8/Windows® 8.1

Temperature
Operating: 5°C-35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

Model A:

340mm(w) * 241mm(d) * 11 - 25.4mm(h)
(Height excluding battery area)

2.15 kg with 48.84WH Battery & ODD

Model B:

374mm(w) * 252mm(d) * 14 - 25.4mm(h)
(Height excluding battery area)

2.2kg with 48.84WH Battery & ODD
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